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Support and Resources
Get the support you need from Safe Software.

Training
Training courses on FMEDesktop are offered by Safe Software and our reseller network.

Access training at http://www.safe.com/learning.

l Recorded: Take our full-length FMEtraining courses for free at your own pace. Each

course includes hours of instructional video from one of our trainers, hands-on exer-

cises with sample data, and a copy of the course manual.

l Live Online: Get live hands-on training from FME-certified trainers in our virtual

classroom. All of Safe Software's online courses include a virtual machine complete

with FMElicense, sample data, workspaces, and a copy of the course manual.

l In-Person: Browse a list of FMEtraining courses held in cities throughout the world.

Or, contact your Safe Software account manager or your FMEreseller to arrange a

private training course for your organization.

Downloads & Documentation
Access the latest FMEbetas, service packs, documentation and other helpful technical

resources.

Access FMEDownloads

Access FMEDocumentation

Support and Resources 8

http://www.safe.com/learning
http://www.safe.com/support/support-resources/fme-downloads/
../../../../../Content/FMEInstallation/Accessing_Product_Documentation.htm


FME Community
The FME Community (https://community.safe.com/s/) is the online source for all inform-

ation on Safe Software products, including:

l Knowledge Base: Our library of authoritative how-to's, FAQs, demos, and more.

l Community Answers: Ask questions and get answers from our community of cus-

tomers and partners.

l Ideas Exchange: Help improve FME. Suggest, vote, and comment on new features.

Support
We are happy to help. Visit https://community.safe.com/s/support for more information.

Live Chat/Leave a Message
Not able to find what you want?We are online or only a message away. On almost every

page at www.safe.com, you will see a dialog that allows you to ask us a question.

Safe Software Partner Program
At Safe Software, we are enthusiastic about equipping people with tools and training.

We have several partnership programs designed to promote the development of FME

skills and extend FME's capabilities to suit your specific needs:

l Value-Added Resellers (VAR) Program: Represent an established brand in your

region.

l Consultant Partner Program: Receive FMEtools and training that you can use to help

your clients.
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l Developer Partner Program: Obtain an FMEdevelopment license to extend the tech-

nology to work within your own applications.
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Accessing Product Help Files
In-depth technical reference documentation is available on the safe.com website at

https://community.safe.com/s/documentation, and is also included with your

FME installation.

By default, when Help is invoked from any FMEDesktop tool (FME Workbench, FME Data

Inspector, and others), it is opened from the safe.com website. This means that you will

always see the latest help topics for updates and for new features.

You can change this default behavior and access product documentation from the help

files that are installed locally (for example, if Internet access is unreliable or is not avail-

able).

To change the default help location

1. Start FME Workbench.

2. On the menu bar, click Tools and select FME Options.

3. On the sidebar of the FME Options page, click Default Paths.

4. Under "Documentation Help Locations," click the checkbox besideUse Offline

Help.

5. Click OK.

6. Restart FME Workbench.

Accessing Product Help Files 11
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Getting Started and System
Requirements

Before You Begin
Before installing FMEDesktop, Safe Software recommends that you exit all programs,

and ensure that the installation directory has access permission for all FMEusers who

may log onto that computer.

In this Section

Prerequisites

l You have system administrator privileges in the installation environment.

l The installation environment must meet the minimum requirements listed on the

FMEDesktop Technical Specifications.

l If you have purchased FME Desktop, you will need:

l The FME Desktop installer. If you do not already have the installer, download it

from here.

l The Serial number or license file that was provided by Safe Software. To get your

serial number, see the confirmation e-mail you received after purchasing FME

Desktop.

l If you are evaluating FME Desktop, obtain the FMEDesktop Trial Installer. If you

require assistance after installing, contact fmetrial@safe.com.
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Other Requirements

Windows

l Note: To install FMEon a server for use with a thin-end client (for example, a

Citrix®installation), you must use an FMEfloating license. To install floating

licenses, you must be running a TCP/IP network.

Linux: Red Hat and CentOS

Check for Active Subscription (Red Hat Only)

FMEmay not be installed on a Red Hat instance unless it has an active subscription.

For more information:

l https://access.redhat.com/documentation/en-us/red_hat_subscription_man-

agement/1/html/quick_registration_for_rhel/

EPEL Package Repository

On Red Hat or CentOS, you must first download and install the Extra Package for

Enterprise Linux (EPEL) Community Project repository.

For more information:

l https://fedoraproject.org/wiki/EPEL#How_can_I_use_these_extra_packages.3F

See also:

l http://www.rackspace.com/knowledge_center/article/install-epel-and-addi-

tional-repositories-on-centos-and-red-hat

NumPy and Matplotlib

NumPy and Matplotlib must be installed, via pip and pip3. This may be done before

or after installing FME.
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Determining the FME License Type to Install
Safe Software offers flexible licensing options for FME.

The type of license that you receive (fixed or floating) is determined at the time of your

request for evaluation or purchase.

Single-Fixed License
Asingle-fixed FMElicense (also known as node-locked or CRClicense) enables FMEto

work on a single specified computer. The FME Licensing Assistant generates a unique

registration key for that computer, which is used to create the license. If FMEis installed

on more than one computer, each computer requires its own license.

By default, all evaluation licenses are single-fixed, unless you specify otherwise.

We recommend using a floating license when installing FMEon a virtual machine. Safe

Software may not provide updated license files if the registration key of the physical

machine is no longer valid due to frequent hardware changes. For more information, see

About Floating Licenses.

l Installing Single-Fixed Licenses

Floating License
Afloating license means that a single computer is provided with a number of licenses

and acts as a server by issuing these licenses to any other computer that requests one. A

floating license is a common way for a company to share a limited number of licenses

among its FMEusers.

AFlexNet software license manager provides the floating license capability to FME. The

FlexNet software is installed on a computer that acts as a license server. Every time FME

is started on a computer, the server issues a license, provided there is one still available.

When a computer closes FME, that license is returned. For example, consider a five-seat
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floating license and 30 workstation computers. Each workstation has FMEinstalled. Any

workstation can run FME, but only a maximum of five at any one time.

To install FMEon a server for use with a thin-end client (for example a Citrix/Winframe

installation), it is highly recommended that you use a floating license. Fixed licenses can

be used, but keep in mind that you will need a fixed license for each user who will be

making use of the software.

For failover purposes, there is an additional option to install an array of three licenses

on three separate servers.

For more information, see About Floating Licenses.

Glossary of Terms

Activation

Associating a registration key with a single-fixed license, using the FMELicensing Assist-

ant.

Borrowing (a floating license)

If your FMEDesktop product uses a floating license, and your organization supports this

option, a computer that will not be connected to the license server can borrow a license

for offline use and run FMEfor a maximum of 30 days.

The computer must be connected to the license server at the time of borrowing.

Floating License

Afloating license means that a single computer is provided with a number of licenses

and acts as a server by issuing these licenses to any other computer that requests one. A

floating license is a common way for a company to share a limited number of licenses

among its FMEusers.
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Floating License Manager

AFlexNet software license manager provides the floating license capability to FME. The

FlexNet software is installed on a computer that acts as a license server. Every time FME

is started on a computer, the server issues a license, provided there is one still available.

When a computer closes FME, that license is returned. For example, consider a five-seat

floating license and 30 workstation computers. Each workstation has FMEinstalled. Any

workstation can run FME, but only a maximum of five at any one time.

Grid Shift File

Grid shift files are used when reprojecting between coordinate systems that have dif-

ferent datums. FMEsupports conversions between coordinate systems using different

datums. Many datum transformations are not mathematically definable and require the

use of grid of shifts. If you attempt to make a datum transformation of this kind without

the appropriate grid shift file in place FMEwill abort the translation.

Single-Fixed License

Asingle-fixed FMElicense (also known as node-locked or CRClicense) enables FMEto

work on a single specified computer. The FME Licensing Assistant generates a unique

registration key for that computer, which is used to create the license. If FMEis installed

on more than one computer, each computer requires its own license.
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Installing FME Desktop

Installing FME Desktop on Microsoft Windows

1. If you downloaded FMEfrom www.safe.com, double-click the downloaded file.

2. On the FME Desktop Installation Extractor dialog, specify a Destination folder in

which to extract installation files. Note that this folder only specifies where install-

ation files are extracted—it does not specify where FMEDesktop program files are

installed. That location is specified later in the installer.

Tip: Take note of the specified Destination folder location. Following install-

ation, you may wish to:

Review the installation .log file

Remove these files to save disk space.

3. Click Install.

4. When extraction is complete, the installer opens. On the Welcome to FMEDesktop

screen, click Next.

5. Follow the instructions in the installation wizard.

Express or Custom Install?

The FME Desktop installer gives you the option of an Expressor Custom install-

ation. If you choose Express, the following installation settings are configured auto-

matically. If you choose Custom, the installer gives you the option of configuring

each setting separately.

Note: If you choose Custom, FME saves the specified settings as new default

values for subsequent Express installations on the same machine.
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Setting Description Default

Value in

an Ini-

tial

Express

Install

Associate FME

with the sup-

ported file

formats

Whether to associate FME Desktop with its supported file

formats, which enables Windows Explorer right-click

functionality to open, view, translate, and transform files

using FME Desktop.

Yes

Install Python

2.7

Whether to include an optional Python 2.7 interpreter

with the installation. (APython 3.7 interpreter is

installed by default.)

WARNING: The Python 2.7 interpreter relies on the

Visual Studio 2008 runtime, which has security vul-

nerabilities. If you have existing FME Desktop work-

spaces that reference Python 2.7, we strongly

recommend upgrading them to reference Python 3.x

in lieu of installing the Python 2.7 interpreter.

No

Install Soft-

ware Devel-

opment Kit

Whether to install the SDK, which provides access to

FMEObjects and FMEPlug-in Builder APIs. You can use

the APIs to create your own applications and plug-ins

that make use of FMEfunctionality.

No

Implicit

NAD27 <->

Whether implicit NAD27 to NAD83 datum shifts use Cana-

dian or U.S. grid shift files. If None, FME prompts for a

None
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Setting Description Default

Value in

an Ini-

tial

Express

Install

NAD83 Datum

Shift

selection at workspace runtime.

Note: You can change this setting after installation

in the FME Options menu. For more information, see

Coordinate Systems.

6. When FME is finished installing, the Licensing Assistant starts.

Installing FME Desktop from the Windows Com-

mand Prompt
We recommend installing FME Desktop using the installation wizard. However, installing

from the command prompt may be useful when you want to perform a silent or remote

installation.

About the Installer

The FME Desktop installer is a self-extracting executable from which you can directly call

an installer package (MSI) in a single command. Alternatively, you can manually extract

installation files, then call the MSI file to silently install.

Note: Acommand prompt installation does not prompt you to uninstall any pre-

vious versions of FMEthat are in the same folder. We strongly recommend that you

uninstall any previous FMEbefore silently installing another into the same folder.
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Performing an Installation

Example Syntax

Extract the installer to C:\FME\ installer and install with all

default options

This examples assumes you are running a command line from a directory that contains

an installer named fme-desktop-win-x64.exe.

fme-desktop-win-x64.exe -d"C:\FME\installer" -s -sp"/qb /nore-

start INSTALLLEVEL=3 ENABLE_POST_INSTALL_TASKS=no"

Extract the installer to C:\FME\ installer and install to C:\Pro-

gram Files\FME12345

This examples assumes you are running PowerShell from a directory that contains an

installer named fme-desktop-win-x64.exe.

./fme-desktop-win-x64.exe -d"C:\FME\installer" -s -sp"/qb /nore-

start INSTALLLEVEL=3 ENABLE_POST_INSTALL_TASKS=no INSTALLDIR-

R=""""""""C:\Program Files\FME12345"""""""""

Executable Parameters

-d<path>

Sets the destination folder for unpacked files.

-s, -s1, -s2

Silent mode. Switch -s is a brief form of -s1. Both -s and -s1 hide the main dialog and

extraction progress. -s2 hides the start dialog, but extraction progress is displayed.

-sp<par>

Silent parameters to pass to the extracted MSI installer when it is run. For more inform-

ation, see MSI-Specific Parameters, below.
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Note: Quotations must be escaped with eight quotations (see example, above).

Installing from the MSI

Use the following syntax to perform a silent installtion from an MSI that was already

extracted manually from the installer executable.

Note: You may need to unblock the downloaded .msi file in order to run it. To

unblock a file, use the Unblock-File command in the Windows PowerShell utility.

For more information, see https://docs.microsoft.com/en-us/-

powershell/module/microsoft.powershell.utility/unblock-file?view=powershell-6.

msiexec /i <path_to_installer> /qb INSTALLLEVEL=3

INSTALLDIR="<installdir>" ENABLE_POST_INSTALL_TASKS=no

Example:

msiexec /i fme_beta.msi /qb INSTALLLEVEL=3 INSTALLDIR="C:\Program

Files\FME" ENABLE_POST_INSTALL_TASKS=no

Note: INSTALLLEVEL=3 must always be specified when installing silently from the

command line.

MSI-Specific Parameters

Flags

Note: To view all flags, type msiexec and hit Enter.

/i <installFile.msi>

Installs the package specified by <installFile.msi> on your computer.

/q[n|b]

Quiet mode. If /qb is specified, a dialog with a progress bar displays, but there is no user

interaction. If /qn is specified, no GUI displays.
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When /qn is specified, the installer appears to return immediately; however, the install-

ation process continues to run in the background. When installing silently, we recom-

mend enabling logging (see below) so you can check for errors.

/x <installFile.msi>

Uninstalls <installFile.msi> if it is installed on your system.

/l*v <logfile>

Enables verbose logging of the installation to <logfile>.

Directives

Directives are specified after flags, in the following format:

<directive name>=<directive value>

General Directives

INSTALLLEVEL

If installing with the /q flag, the directive INSTALLLEVEL=3 must be specified for the

installation to proceed correctly.

INSTALLDIR

Specifies the full path location of the main installation directory. If the directory does

not exist, it is created. Spaces may be used with quotes.

The default path is C:\Program Files\FMEon Windows XP, and C:\apps\FMEon Windows

Vista and later.

Installer Behavior Directives

The following directives affect the installer's runtime behavior.

ENABLE_SOUNDEVENTS

Sets up sound events. Allowed values are yes and no (case-sensitive). Default is yes.

CHECK_ADMIN_RIGHTS
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Checks to ensure that the user installing FMEhas admin privileges. Allowed values are

yes and no (case-sensitive). Default is yes.

ENABLE_SHORTCUTS

Creates shortcuts in the Windows Start menu. Allowed values are yes and no (case-sens-

itive). Default is yes.

ENABLE_FILETYPE_REGISTRATION

Enables FMEapplications to view, open, and work with FMEfiles and GISdata files.

Allowed values are yes and no (case-sensitive). Default is yes.

ENABLE_PATH_UPDATE

Allows the installer to update the PATH environment variable. Allowed values are yes

and no (case-sensitive). Default is yes.

ENABLE_STANDARD_EXE_INSTALLATION

Installs all of the standard FMEexecutables (Data Inspector, Workbench, etc). Allowed

values are yes and no (case-sensitive). Default is yes.

ENABLE_LICENSE_COPY

Allows the installer to search for old license files, and copy them into the current install-

ation folder if present. Allowed values are yes and no (case-sensitive). Default is yes.

ENABLE_POST_INSTALL_TASKS

Controls whether the license wizard is run after the installer has completed. See also

FMEREG_CMDLINE(below). Allowed values are yes and no (case-sensitive). Default is

yes.

FMEREG_CMDLINE

Passes values into the license wizard (fmelicensingassistant_cmd.exe) at install time to

automate licensing, using syntax similar to Licensing FME Desktop from the Windows

Command Prompt. For example, to license FMEwith a Smallworld license on floating
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license server named "license_server", specify FMEREG_CMDLINE="--floating license_

server smallworld". For license type (FMEedition) values, see Specifying the

FME Edition to Use.

ENABLE_ZERO_SIDE_EFFECT

Sets the following options to "no":

ENABLE_SOUNDEVENTS, CHECK_ADMIN_RIGHTS,INSTALL_SYSTEM_DLLS, ENABLE_

SHORTCUTS,ENABLE_FILETYPE_REGISTRATION, ENABLE_POST_INSTALL_

TASKS,ENABLE_PATH_UPDATE,ENABLE_LICENSE_COPY

Allowed values are yes and no (case-sensitive). Default is no.

ENABLE_NAD83_NAD27_DATUMSHIFTS

Controls whether implicit NAD27 to NAD83 Datum Transformation is set to USAor

CANADA. Allowed values are yes, no and none. Default is no, which sets this directive to

USA. Ayes setting specifies CANADAonly. Specifying none disable the transformation,

which causes workspaces to error when trying to use that shift.

REPORTSTATISTICS

Controls whether statistics about format and transformer use are sent to Safe Software.

Allowed values are yes and no (case-sensitive). Default is yes.

File Installation Directives

Some files that are installed by the installer can be omitted by these directives.

INSTALL_USER_DOCUMENTS

Installs directories to the user's 'Documents' folder, including a 'My FMEWorkspaces'

folder. Default is yes.

INSTALL_SYSTEM_DLLS

Updates older system DLLs as needed, and run the Microsoft Visual Studio C++ Runtime

Installer. Allowed values are yes and no (case-sensitive). Default is yes.
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If set to no, the user is responsible for manually running the C++ Runtime installer, and

ensuring that atl.dll and atl71.dll are installed on the target system. This option is not

recommended, and may lead to non-functional FMEinstallations.

INSTALL_THIRDPARTY

Installs application extenders. Allowed values are yes and no (case-sensitive). Default is

yes.

Enabling application extenders is controlled by the FMEAdministrator.

INSTALL_FMEOBJECTS

Installs FMEObjects DLLs and other components. Allowed values are yes and no (case-

sensitive). Default is yes. For more information, see Installing the Software Development

Kit for FMEDesktop.

INSTALL_GALLERY

Installs the gallery directory. Allowed values are yes and no (case-sensitive). Default is

yes.

INSTALL_HELP

Installs the help directory. Allowed values are yes and no (case-sensitive). Default is yes.

INSTALL_HELP_DLL

Installs the help DLLs. Allowed values are yes and no (case-sensitive). Default is yes.

INSTALL_METAFILE

Installs the metafile directory. Allowed values are yes and no (case-sensitive). Default is

yes.

INSTALL_PLUGINBUILDER

Installs the pluginbuilder directory. Allowed values are yes and no (case-sensitive).

Default is yes.
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INSTALL_REPROJECT

Installs the Reproject directory. Allowed values are yes and no (case-sensitive). Default is

yes.

INSTALL_TCL

Installs the tcl directory. Allowed values are yes and no (case-sensitive). Default is yes.

INSTALL_WORKBENCH_EXE

Installs the the FME Workbench application. Allowed values are yes and no (case-sens-

itive). Default is yes.

INSTALL_FME_EXE

Installs the fmeapplication. Allowed values are yes and no (case-sensitive). Default is

yes.

INSTALL_FMEADMIN_EXE

Installs the FMEAdministrator application. Allowed values are yes and no (case-sens-

itive). Default is yes.

INSTALL_FMEVIEW_EXE

Installs the FMEUniversal Viewer application. Allowed values are yes and no (case-sens-

itive). Default is yes.

INSTALL_FMEGUI_EXE

Installs the FMEUniversal Translator application. Allowed values are yes and no (case-

sensitive). Default is yes.

INSTALL_FMEREG_EXE

Installs the FMELicensing Assistant application. Allowed values are yes and no (case-

sensitive). Default is yes.

INSTALL_WHATSNEW

Installing FMEDesktop 26



Installs the what's new/great text files. Allowed values are yes and no (case-sensitive).

Default is yes.

INSTALL_FMECOMUTIL_DLL

Installs the fmecomutil DLL. Allowed values are yes and no (case-sensitive). Default is

yes.

INSTALL_FME_SHELLEXT_DLL

Installs the fme shell extension DLL. Allowed values are yes and no (case-sensitive).

Default is yes.

INSTALL_SPATIAL_ASSISTANT_EXE

Installs spatialassistant.exe. Allowed values are yes and no (case-sensitive). Default is

yes.

INSTALL_FMEGEOS_DLL

Installs geos_fme.dll. Allowed values are yes and no (case-sensitive). Default is yes.

INSTALL_PYTHON27

Installs a Python 2.7 interpreter. (APython 3.7 interpreter is installed by default.)

Allowed values are yes and no (case-sensitive). Default is no.

WARNING: The Python 2.7 interpreter relies on the Visual Studio 2008 runtime, which

has security vulnerabilities. If you have existing FME Desktop workspaces that ref-

erence Python 2.7, we strongly recommend upgrading them to reference Python 3.x

in lieu of installing the Python 2.7 interpreter.

Post-Install Tasks

Licensing FME Desktop from the Windows Command Prompt

Expand for Details

You can activate an FMEinstallation for a floating license using the following syntax:
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fmelicensingassistant --floating <server>[:<port>] <license type>

For example:

fmelicensingassistant --floating testserver oracle

To get the proper values for <license type>, run:

fmelicensingassistant_cmd.exe --query <server>[:<port>]

For example:

fmelicensingassistant_cmd.exe --query testserver

MSSQL Formats Only

Expand for Details

If you plan to run workspaces that reference Microsoft SQL Server and Azure SQL Data-

base (MSSQL_*) readers and writers, you must manually install the OLEDB Driver for

SQL Server and Microsoft System CLRTypes for SQL Server. To install, navigate to the

[INSTALLDIR] and run:

msiexec /i msoledbsql.msi /qb IACCEPTMSOLEDBSQLLICENSETERMS=YES

msiexec /i SQLSysClrTypes.msi /qb

Updating to a Newer FME Version
If you are updating to a newer version of FME, follow these steps.

Make sure you back up or relocate any custom files that you have saved in your FME

installation directory.

1. Download and run the new installation file.

2. On the FME Desktop Installation Extractor dialog, specify a Destination folder in

which to extract installation files. Note that this folder only specifies where install-
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ation files are extracted—it does not specify where FMEDesktop program files are

installed.

Tip: Take note of the specified Destination folder location. Following install-

ation, you may wish to:

Review the installation .log file

Remove these files to save disk space.

3. Click Install.

4. When extraction is complete, the installer opens. On the Welcome to FMEDesktop

screen, click Next.

5. On the Destination Folder dialog, specify a destination folder and click Next.

6. If the installation wizard finds a previously installed version of FMEin the specified

destination folder, the installation wizard asks if you would like to uninstall it. If

you answer Yes, click Next. If you answer No, click Back and enter a new des-

tination folder. You can install multiple versions of FME Desktop.

7. follow the remaining instructions in the installation wizard.

Installing FME Desktop on Linux

Updating to a Newer FME Version 30

Updating Linux 30
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Multiple Installations of FME Desktop in Parallel 34
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Updating to a Newer FME Version
If you are updating to a newer version of FMEDesktop, you must first manually uninstall

the earlier version. Alternatively, you can install to a different directory and have mul-

tiple versions of FME Desktop (see Updating to a Newer FMEVersion, below).

Make sure you back up or relocate any custom files that you have saved in your FME

installation directory.

Uninstalling

Run the following command, "as root", depending on your Linux distribution:

l Debian, Ubuntu:

apt remove fme-desktop-<release>

For example:

apt remove fme-desktop-2018

l RedHat, CentOS:

yum remove fme-desktop-<release>

For example:

yum remove fme-desktop-2018

What's Next?

Proceed to Updating Linux.

Updating Linux
To avoid dependency errors, we recommend updating Linux before installing.

Offline Updating and Installation
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FMEon Linux requires many third party packages. These dependencies must be satisfied

when FMEis installed. The easiest way to satisfy these dependencies is to install FMEon

a computer that is connected to the internet, allowing packages to be downloaded as

needed.

It is possible, however, to manually prepare an offline computer for FMEinstallation.

For more information:

l Ubuntu/Debian: Installing packages without an Internet connection

l Red Hat/CentOS: https://access.redhat.com/solutions/29269

Dependencies can be determined on-demand by using one of the following commands

l Ubuntu/Debian: dpkg -I <package_name>

l Red Hat/CentOS: yum deplist <package_name>

WARNING: If you are accessing local mirrors of public repositories, ensure they

match the version of your Linux.

Debian, Ubuntu

apt update && apt upgrade

RedHat, CentOS

yum update

What's Next?

Proceed to Installing.

Installing
Before installing, be sure to:
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1. Review the installation Prerequisites.

2. Update Linux.

All installation steps must be performed "as root" (via the sudo command on some dis-

tributions). FMEDesktop is installed for ALL users.

The install location is /opt/fme-desktop-<release>. (For example, /opt/fme-desktop-

2017.) When complete, the installer generates a configuration (.cfg) file to the install dir-

ectory.

The following installers are available:

Platform Installer Name Example

Debian,

Ubuntu

fme-desktop-<release>_

<version>.<build>_amd64.deb

fme-desktop-2017_

2017.0.0.0.17228~ubuntu.18.04_

amd64.deb

RedHat,

CentOS

fme-desktop-<release>-<version>-

<build>.x86_64.rpm

fme-desktop-2017-2017.0.0.0-17228.el7.-

centos.x86_64.rpm

Downloading the Installer

Download the FMEDesktop Installer to your local machine. To obtain the installer, visit

http://www.safe.com/support/downloads.php.

Running the Installer Using the Package Manager

To use the package manager to install FME Desktop and all dependencies, double-click

on the package.

Note: The Debian installation package does not support the Ubuntu Unity package

manager previous to version 16.04.2. Instead, use the command line to install.
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Running the Installer Using the Command Line

Run the following commands, depending on your Linux platform, substituting

<release>, <version>, and <build> with the corresponding values from your installer

name.

Debian package:

If gdebi is not already installed: apt install gdebi-core

gdebi fme-desktop-<release>_<version>~ubuntu.<build>_amd64.deb

RedHat, CentOSpackage:

yum install fme-desktop-<release>-<version>.e17.centos.x86_

64.rpm

Alternatively, to install to a non-default location, you must first manually install

FME dependencies:

yum deplist fme-desktop-<release>-<version>.el7.centos.x86_

64.rpm | grep provider | awk '{print $2}' | sort | uniq | sed

':a;N;$!ba;s/\n/ /g' | xargs yum install -y

Next, run:

rpm -Uvh --relocate /opt=/usr/etc/fme --relocate /us-

r=/usr/fmeicons fme-desktop-<release>-<version>.el7.centos.x86_

64.rpm

Each --relocate argument relocates a prefix to a new location. In the preceding

example, fme installs to /usr/etc/fme/fme-desktop-<release> and the icons, shortcuts,

and others will install to /usr/fmeicons. Note that these arguments are optional, you can

relocate both prefixes, one, or none.

What's Next?

To license FME Desktop, see Licensing.
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Multiple Installations of FME Desktop in Parallel
If you want to have multiple of installations of FME Desktop on the same system, we

recommend the following procedure:

1. Install the first copy of FMEDesktop as described in Installing FMEDesktop on

Linux.

2. Copy the contents of the install directory (/opt/fme-desktop-<release>) to another

location (for example, /home/user/fme-desktop-b18228).

3. Install the second copy of FMEDesktop as described in Installing FMEDesktop on

Linux.

4. Run the first copy of FMEDesktop directly from the location to which it was copied

(for example, /home/user/fme-desktop-b18228) - not from a desktop shortcut.

You can run the second copy of FME Desktop from a desktop shortcut, which

points to the original install location (/opt/fme-desktop-<release>).

Installing FME Desktop on Mac

1. Double-click the FME Desktop.dmg file.

2. On the FMEDesktop Installer dialog, double-click the FME icon.

3. Follow the instructions in the installation wizard.

4. When FME finishes installing, the Licensing Assistant starts.
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Licensing
Installing a Single-Fixed License 35

About Floating Licenses 44

Licensing from the Linux Command Line 80

Getting Your Current Licensing Status 81

Installing a Single-Fixed License
Asingle-fixed FMElicense (also known as node-locked or CRClicense) enables FMEto

work on a single specified computer. The FME Licensing Assistant generates a unique

registration key for that computer, which is used to create the license. If FMEis installed

on more than one computer, each computer requires its own license.

Before You Begin
To get your serial number, see the confirmation e-mail you received after purchasing

FMEDesktop. If you do not know or cannot find your serial number, please send an e-

mail to codes@safe.com to request a license file.

To activate your license you will need an Internet connection.

Activating a Single-Fixed License
If you have a serial number and an Internet connection, follow these steps to activate a

fixed license from Safe Software.

If you already have a licensed installation, you will be prompted to update it.
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1. Open the FME Licensing Assistant

l On Windows, click the Start menu > Programs > FMEDesktop > Utilities > FME

Licensing Assistant.

l On Linux, log in as the same user who installed FMEDesktop. Navigate to

Application > FMEDesktop > Utilities > FMELicensing Assistant.

l On Mac, /Library/FME/<version>/Apps/FMELicensing Assistant.

2. The FMELicensing Assistant opens.

3. Select Activate a single-fixed license. Enter the Serial Number in the corresponding

field, and click Activate. To get your serial number, see the confirmation e-mail you

received after purchasing FMEDesktop.

4. Click Finish.

You will see a confirmation message when FMEDesktop is successfully licensed.

Troubleshooting

If you change your system's hardware configuration after installation, or move your

installation to a new system, your license may not work and you will need to enter your

serial number into the licensing assistant as described above.

If you are unable to use the FMELicensing Assistant to activate a license, see Installing a

License File Provided by Safe Software.
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Other Licensing Options

l To connect to a floating license server, see Installing a Floating License Server on

Microsoft Windows.

l To activate a trial version of FME, visit: https://www.safe.com/fme/fme-desktop/trial-

download/

Installing a License File Provided by Safe Software
Follow the steps below if you have a problem with the automated license generator. If

this happens, you will need to install a license file (*.fmelic) provided by Safe Soft-

ware.

For Linux users, you must log in as the same user who installed FME Desktop.

1. Go to the FMEDesktop License Activation web page (http://www.safe.-

com/activation/).

2. Provide the following:

l Serial number. To get your serial number, see the confirmation e-mail you

received after purchasing FMEDesktop.

l Your 10-digit registration key, which is located at the bottom left corner of the

install pane of the FMEDesktop Licensing Assistant:

Note: The number shown here is an example only.

3. Click Retrieve License File and download the file.
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If the previous steps are unsuccessful, you can also send an e-mail message to

codes@safe.com with your serial number and registration key. You will receive an

e-mail message from Safe Software with an attached .fmelic license file.

4. Open the FMEDesktop Licensing Assistant (fmelicensingassistant.exe)

l On Windows, the Licensing Assistant is in the Start menu under FME Desktop,

or fmelicensingassistant.exe in the root folder of the FME Desktop install dir-

ectory.

l On Linux, the Licensing Assistant is in the Applications menu, or in the root

folder of the FME Desktop install directory.

l On Mac, the Licensing Assistant is in /Library/FME/<version>/Apps/FMELicens-

ing Assistant.

5. Click Install a license file provided by Safe Software.

6. Browse to the location of your license file and click Activate.
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7. Click Finish.

FME Desktop is successfully licensed.

Licenses are tied to physical properties of systems. If you change your system's hard-

ware configuration, your FMElicense may not work and you will need to request a new

one.

Troubleshooting Single-Fixed Licenses

About the Registration Key

Aregistration key is a unique ID generated from system information by the FMELicens-

ing Assistant. It is Safe's method of limiting a single-fixed license to a single computer.

Safe needs the registration key from your installation to create a license for FME.

In most cases, such as when you are requesting an evaluation license or a new license

for an updated FMEversion, the Licensing Assistant is able to pass the key on to Safe

automatically, allowing us to create a matching license immediately.
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However, in some cases, you will need to quote the number to us directly. Some

examples of when this may happen are:

l The connection to the Safe server is not working.

l We need to see the code to help debug a license problem.

The registration key is shown in the bottom left of the FMELicensing Assistant:

It can also be found in FME Workbench or Data Inspector under Help > About... > More

Info.
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Changing Computers

When you move FMEto another computer, you will need a new license, since the new

computer's registration key will not match the one encoded within your existing license.

Ask for a new license by entering your serial number into the FMELicensing Assistant of

the new computer/FMEinstallation that you wish to license. To get your serial number,

see the confirmation e-mail you received after purchasing FMEDesktop.

The new license created on our Safe license server will be for your new registration key.

If you have any issues, contact codes@safe.com.

Virtual Machines

We recommend using a floating license when installing FMEon a virtual machine. Safe

Software may not provide updated license files if the registration key of the physical

machine is no longer valid due to frequent hardware changes. For more information, see

About Floating Licenses.
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The Licensing Wizard fails with "Unable to create local license files"

error message

This error indicates the Licensing Assistant was not run as Administrator.

To run the Licensing Assistant as Administrator

Click Programs > FMEDesktop > Utilities, right-click on FMELicensing Assistant, and

select Run as administrator.

It may also help to delete any existing licenses from the directory <FME>\licenses\.

I installed my license but I still cannot run FME Workbench

l Ensure that your machine key matches the key in your license file. Open your license

file at <FME_Dir>\licenses\fme_license.fmelic in a text editor. You will see a line

labeled MACHINECODE. The code shown here must match exactly your registration

key shown on the bottom left of the Licensing Assistant1. If they do not match, you

will need to request another license. You cannot edit a license file directly.

l Does it appear that your license has expired?Ensure you have installed your per-

manent license. If you have not received your permanent license you may need to

request it. A temporary license may also stop working if you have changed the time

and date settings on your computer, and you will need to contact your account man-

ager to request a new license.

l Do you see a message, "Duplicate license file.”?This is not an error, and FMEshould

still run correctly. At times, an unlicensed FMEwill try to contact our licensing server

to see if there is a license available for that serial number. If so, it automatically

licenses itself. This message is caused when you try to manually license FMEusing

the same license it has already automatically obtained for itself.

l Do you see a message, "FMELicensing Notice Your current license is AutoDesk Map.

This application cannot be used with current license..."?You may be using a Training
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or Generic license. Using your file explorer, navigate to the licenses directory of your

FMEinstallation directory: <FME_Dir>\licenses. Delete every file in this directory

except the file fme_license.fmelic. Restart FMEWorkbench or the FMEapplication

you were attempting to use.

l Do you see a message, "Administrator permissions are required to license FME..."?

The licensing assistant may need to be run with elevated privileges. Click Programs >

FMEDesktop > Utilities, right-click on FMELicensing Assistant, and select Run as

administrator.

l If you have confirmed the machine key matches your license file and still cannot

license FME, or you see error code -500 or -501, in rare cases a registry entry may be

blocking your license. Run regedit and navigate to HKEY_LOCAL_

MACHINE\SOFTWARE\Safe Software Inc.\LICENSE. Delete the key called LICENSE.

l Do you see a message, "License quota exceeded..."?Please contact the Technical

Support Team.

l Do you see another message?Please go to https://-

community.safe.com/s/article/troubleshooting.

1To Run the FMELicensing Assistant go to Start > Programs > FMEDesktop > Utilities >

FMELicensing Assistant. In previous versions of FMEthis is also known as the FME

Licensing Wizard and may be found in a slightly different location.

FME is licensed but I am still having licensing trouble

l Are you having trouble with a specific format that you cannot see in the format list

or FMEcannot read or write to it?Some formats in FMErequire a higher level of

licensing, and some formats are provided by 3rd party vendors. Also, some formats

require another application to be installed. In particular, reading/writing ESRI

Geodatabase requires a licensed ArcGISinstallation and GeoMedia Access Ware-

house writing requires a licensed GeoMedia installation. For a complete list of
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formats and required helper applications, see http://www.safe.com/fme/format-

search/. If you would like to upgrade your FMEto use a specific format, contact your

account manager or sales@safe.com.

l Are you experiencing another problem?Contact the Technical Support Team. It may

help to ensure that you are, in fact, running a fixed license. Please include the

FMEReport.html file by running the FMETroubleshoot.bat file from the General

Troubleshooting page.

About Floating Licenses
Afloating license means that a single computer is provided with a number of licenses

and acts as a server by issuing these licenses to any other computer that requests one. A

floating license is a common way for a company to share a limited number of licenses

among its FMEusers.

AFlexNet software license manager provides the floating license capability to FME. The

FlexNet software is installed on a computer that acts as a license server. Every time FME

is started on a computer, the server issues a license, provided there is one still available.

When a computer closes FME, that license is returned. For example, consider a five-seat

floating license and 30 workstation computers. Each workstation has FMEinstalled. Any

workstation can run FME, but only a maximum of five at any one time.

For a full description, visit the Flexera Software website: http://www.flexera.com.

Afloating license serves multiple instances of FMEDesktop that are installed locally on

each computer (recommended); or to a single installation on a networked application

server that is accessed remotely by individual users.
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Afloating license can serve different FMEeditions. For example, a floating license can

serve both FMEProfessional Edition and FMESmallworld Edition.

If the expiry dates associated with multiple FMEinstallation serial numbers vary, the

floating license applies the shortest expiry date to all serial numbers.

If you need to transfer an existing floating license to a new license server, you must per-

form a new installation since you still need to request a new license file from Safe Soft-

ware.

To Install a Floating License

l Installing a Floating License on Windows

l Installing a Floating License on Linux

Licensing 45



Three-Server Redundant Floating Licenses
The Flexera License Manager allows for redundancy by using a set of three license serv-

ers. With three-server redundancy, the floating license server stays functional, handing

out its total complement of licenses when any two of the three license servers are up

and running.

Amaster server that performs all licensing operations is elected when the redundant

servers are started. The other two servers provide a secure licensing mechanism in the

event of hardware failure or if the master node needs to be rebooted.

It is not a requirement for each of the server nodes to have the same architecture or

operating system, although they should have reliable network communications with

each other and should be on the same subnet. Often, this means that the three servers

are located physically close to each other.

To Install a Three-Server Redundant Floating License
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l Installing a Three-Server Redundant Floating License Server on Windows

l Installing a Three-Server Redundant Floating License Server on Linux

Installing a Floating License on Windows
To install a floating license on Windows, follow these steps:

1. Before You Begin

2. Download and Run the Installer

3. Request and Install the License

4. Install FMEon Client Computers

5. Start FMERegistration

Before You Begin

Ensure that the following requirements are met before beginning the installation:

l You must be running a TCP/IP network.

l One computer on the network is designated as the license server. The license server

may be any computer on the network that is visible to all computers that are

dependent on it for their licenses. You should choose a computer that is always run-

ning and always connected to the network because the client computers must be

able to communicate with the license server to use the FME. The processing burden

on the licensing server is negligible.

l You must have Administrator privileges to install the FMEFloating License server.

l If the computer you want to use as your floating license server has a firewall, you

must open a port through which the FlexServer can communicate. By default, the

range of ports used is 27000-27009, although you can also configure other ports. For

more information, see Specifying Floating License Server Ports.

Licensing 47

../../../../../Content/FMEInstallation/Before_You_Begin_Install_Floating_License_Windows.htm
../../../../../Content/FMEInstallation/Download_and_Run_the_Installer.htm
../../../../../Content/FMEInstallation/Request_and_Install_the_License.htm
../../../../../Content/FMEInstallation/Install_FME_on_Client_Computers.htm
../../../../../Content/FMEInstallation/Start_FME_Registration.htm
../../../../../Content/FMEInstallation/Specifying_Floating_License_Server_Ports.htm


l If FlexNet is already installed on your license server, you still need to perform a new

installation. FMErequires the version of FlexNet that is included in the installer. In

addition, if your organization is configuring license borrowing (see Borrowing a Float-

ing License), you will require LMTOOLSversion 11.8 or newer.

The FMElicense server cannot be installed on a virtual machine that is built and moved

around among many physical machines. It must be locked to a single fixed MACaddress.

Download and Run the Installer

The FMEinstaller contains the utility program required to get the license server up and

running:

l fme-flexnet-win-x86.msi (Windows 32-bit)

Or

l fme-flexnet-win-x64.msi (Windows 64-bit)

To download and run

1. On the FME Downloads page, specify the desired version under "Select an

FME Version."

2. Under "Floating License Installer for FME Desktop," specify the applicable Windows

bit version, and click Download.

3. On the computer that acts as the license server, run (double-click) the installer to

create a FlexServer directory.

The following table lists the shortcuts that are created in the Safe Software program

group.

Expand for details
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Shortcut Description

Generate hostid.txt Creates a text file that contains the

hostname and Host ID information

required when requesting a floating

license from www.safe.-

com/activation/floating/.

Launch LMTOOLS Launches LMTOOLS. Used for

debugging or changing con-

figuration.

License Administration

Guide

Opens Flexera Software’s License

Administration Guide.

Start - Restart FME

License Server

Starts the license manager process.

View FMELicense Server

Log

Opens the license manager log file.

Used for debugging.

View hostid.txt Reopens text file, if required by Safe

Software.

View Readme Opens the installation and con-

figuration instructions.

Request and Install the License

Perform the following steps on the computer that acts as the license server:

1. Click Start > Programs > FlexNet for Safe Software > View hostid.txt to open the

hostid.txt file.
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If you are installing FlexNet on Windows Vista, Windows 7, or Windows 8 and User

Account Control (UAC) is enabled, right-click Start-Restart FMELicense Server and

run this function using administrator privileges. If UACis not enabled, you do not

have to perform this step.

2. Complete the online license request form:

http://www.safe.com/activation/floating/

You will need a product serial number (for example, BEGP-F7MG-21YL). To get your

serial number, see the confirmation e-mail you received after purchasing FME

Desktop.:

If you do not have a product serial number, e-mail your hostid.txt file to

codes@safe.com.

If you are requesting a combined license and are entering multiple serial numbers,

separate them with commas.

If you do not have hostid.txt and are entering host information manually:

l Hostname is the name of the computer hosting the floating license.

l Host ID is the MACaddress (or "Ethernet address") of the host computer (lower-

case, with no colons).

Your hostid.txt may contain multiple Host IDs; however, you can enter only one in

the online request form.

3. You will receive an email with instructions for installing the license:

a. Save the safe.lic file to the FlexServer directory. For example: C:\Program

Files\FlexServer\
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b. Restart the FMELicense Server:

Start Menu > Programs > FlexNet for Safe Software> Start - Restart FME

License Server

Install FME on Client Computers

After the license server is running, install FMEon the client computers or on the Network

Server (if you have a fast and non-congested network).

If this is a license upgrade from fixed license to floating license (and not a new FME

installation), then ensure that there are no existing fme_license.dat files in the licenses

directory; for example, check C:\Program Files\FME\licenses and C:\User-

s\<username>\Documents\FME\Licenses. Also ensure there are no FMEtasks running

before starting the registration process.

Start FME Registration

Perform this step for each computer that has FME installed.

For command prompt instructions, see Licensing FME Desktop from the Windows Com-

mand Prompt.

1. Open the FMELicensing Assistant: Start > Programs > FMEDesktop > Utilities > FME

Licensing Assistant.
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2. Select Connect to a floating license server, and enter the name of the computer that

is hosting the FMElicenses.

3. Click the Next button.

4. If your configuration contains more than one type of FMElicense, select the license

that you want to use.

5. Click Finish to complete the connection.

Installing a Floating License on Linux
To install a floating license on Linux, follow these steps:

1. Before You Begin

2. Locate the Flexera License Manager Files

3. Create a Directory for the Flexera License Manager

4. Provide the Information to Generate a Floating License

5. Install the Floating License

6. Configure FMEDesktop to Use the Floating License
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Before You Begin

Ensure that the following requirements are met before beginning the installation:

l You must be running a TCP/IP network.

l One computer on the network is designated as the license server. The license server

may be any computer on the network that is visible to all computers that are

dependent on it for their licenses. You should choose a computer that is always run-

ning and always connected to the network because the client computers must be

able to communicate with the license server to use the FME. The processing burden

on the licensing server is negligible.

l You must have Administrator privileges to install the FMEFloating License server.

l If the computer you want to use as your floating license server has a firewall, you

must open a port through which the FlexServer can communicate. By default, the

range of ports used is 27000-27009, although you can also configure other ports. For

more information, see Specifying Floating License Server Ports.

l If FlexNet is already installed on your license server, you still need to perform a new

installation. FMErequires the version of FlexNet that is included in the installer. In

addition, if your organization is configuring license borrowing (see Borrowing a Float-

ing License), you will require LMTOOLSversion 11.8 or newer.

The FMElicense server cannot be installed on a virtual machine that is built and moved

around among many physical machines. It must be locked to a single fixed MACaddress.

Locate the Flexera License Manager Files

If you have purchased an FMEfloating or single-fixed license for Linux, copy the

Linux\FlexServer directories from the FMEinstaller. Alternatively, follow these steps:
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1. On the FME Downloads page, specify the desired version under Select an

FME Version.

2. Under Floating License Installer for FME Desktop, select Linux 64-bit and click

Download. This will download the file: fme-flexnet-linux-x64.tar.gz

Create a Directory for the Flexera License Manager

Create a directory for the Flexera License Manager on your license server computer,

which is the computer that will manage the licenses. Extract the contents of fme-

flexnet-linux-x64.tar.gz into this directory. For example:

% mkdir /opt/FlexServer

% cd /opt/FlexServer

% gunzip < ~/fme-flexnet-linux-x64.tar.gz | tar xf -

This directory is referred to as the FlexServer directory for the remainder of these instruc-

tions.

Provide the Information to Generate a Floating License

Safe Software requires three pieces of information to generate a floating or node-locked

license:

l hostname

l host ID

l FMEserial number

What's Next?

l Install the Floating License

Obtaining the Hostname

To obtain the hostname, type the hostname command. For example:
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% hostname

worf

In this example, the host name is worf.

Determining the Host ID

To determine the host ID, use the lmutil lmhostid command within the FlexServer

directory. The output should be an eight-character alphanumeric string (or a 12-char-

acter alphanumeric string on Linux). For example:

% ./lmutil lmhostid

lmutil - Copyright (c) 1989-2009

The FlexNet host ID of this machine is "807abc12"

In this example, the host ID is 807abc12.

Note: When you are running ./lmutil lmhostid, you may see the following error

message:

>-bash: ./lmutil: No such file or directory

This error appears when FlexNet is missing necessary libraries to run on Linux. To clear

the error, install lsb-core by typing the command:

sudo apt install lsb-core

Determining the FME Serial Number

To get your serial number, see the confirmation e-mail you received after purchasing

FMEDesktop.

Visit www.safe.com/activation/floating/ and submit the Floating License Request.

Safe Software will send you a file called safe.lic that contains the key code file for the

license code server.

Copy the safe.lic file into the FlexServer directory on your license server computer.
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The filename must remain in lowercase text. Safe Software recommends that you do not

change the filename.

Install the Floating License

To start the Flex Server, you must have a /usr/tmp directory.

Verify that the /usr/tmp directory exists and if it doesn’t exist, create this directory as

follows:

% mkdir /usr/tmp

To start the License Manager:

% <FlexServerDir>/lmgrd -c <FLEXServerDir>/safe.lic

This action runs the License Manager in the foreground, logging activity to the terminal.

To store the log to a file instead, use the -l option:

% ./lmgrd -c ./safe.lic -l safe.log

When a log file is used, lmgrd detaches as a background process, so there is no need to

explicitly background the application. However, you’ll have to start the server each time

the license server host is rebooted. The system administrator can make sure the pre-

ceding command is run at system start-up time.

Configuring FME Desktop to Use the Floating License

To configure an installation of FMEto use a License Manager, follow these steps.

1. Once FMEDesktop is installed on Linux, log in as the same user who installed FME

Desktop.

2. Navigate to Applications > FMEDesktop > Utilities > FMELicensing Assistant. The

FMELicensing Assistant opens.
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3. On the FMELicensing Assistant, select Connect to a floating license server button.

4. In the Server Name field, enter the name of the license server. Click Next.

5. Select the FMEEdition from the list and click Activate.

6. Click Finish.
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Afloating license is installed to borrow a license.

Installing a Three-Server Redundant Floating

License Server on Windows
To install Three-Server Redundant Floating Licenses on Windows:

1. Before You Begin

2. Download and Run the Installer

3. Start the License Servers

4. Install FMEOn Client Computers

5. Start FMERegistration

Before You Begin

Ensure that the following requirements are met before beginning the installation:
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l You must be running a TCP/IP network.

l Three computers on the network are designated as license servers. The license serv-

ers may be any computers on the network that are visible to all computers that may

dependent on them for their licenses. You should choose computers that are always

running and always connected to the network because the client computers must be

able to communicate with any one license server to use FME. The processing burden

on the licensing server is negligible.

l You must have Administrator privileges to install the Flexera Licensing Manager.

l If the computers you want to use as your floating license servers have firewalls, you

must open a port on each one through which the FlexServer can communicate. By

default, the range of ports used is 27000-27009, although you can also configure

other ports.

l If FlexNet is already installed on your license servers, you still need to perform a new

installation. FMErequires the version of FlexNet that is included in the installer. In

addition, if your organization is configuring license borrowing (see Borrowing a Float-

ing License), you will require LMTOOLSversion 11.8 or newer.

The FMElicense servers cannot be installed on a virtual machine that is built and moved

around among many physical machines. It must be locked to a single fixed MACaddress.

Download and Run the Installer (Three-Server Redundant Floating

License Server)

The FMEinstaller contains the utility program that is needed to get the license server up

and running:

fme-flexnet-win-x86.msi

or

fme-flexnet-win-x64.msi
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To download and run

1. On the FME Downloads page, specify the desired version under "Select an

FME Version."

2. Under "Floating License Installer for FME Desktop," specify the applicable Windows

bit version, and click Download.

Note: If you are viewing this link in a PDF file, your Acrobat security settings

may prevent access to the installer. Instead, paste https://www.safe.-

com/support/downloads/ into a web browser.

3. On each computer that acts as a license server, run (double-click) the installer to

create a FlexServer directory.

4. Send an e-mail to codes@safe.com and include the FlexNet Host ID, the hostname

assigned to each of the computers, and serial number. To get your serial number,

see the confirmation e-mail you received after purchasing FMEDesktop.

The table that follows lists the shortcuts that are created in the Safe Software pro-

gram group:

Expand for details

Shortcut Description

Generate hostid.txt Creates a text file to send to

codes@safe.com.

Launch LMTOOLS Launches LMTOOLS. Used for debug-

ging or changing configuration.

License Administration

Guide

Opens Flexera Software’s License

Administration Guide.

Start - Restart FMELicense Starts the license manager process.
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Shortcut Description

Server

View FMELicense Server

Log

Opens the license manager log file.

Used for debugging.

View hostid.txt Reopens text file, if required by Safe

Software.

View Readme Opens the installation and con-

figuration instructions.

5. We will e-mail you a file called safe.lic that contains the key code file for the

license code servers. Copy the safe.lic file into each of the FlexServer dir-

ectories on your license server nodes.

Start the License Servers

On all three servers, start the license manager. Go to Start > Programs > Safe Software,

and run Start - Restart FMELicense Server.

If you’re installing FlexNet on Windows Vista, right-click Start-Restart FMELicense Server

and run this function using administrator privileges.

The first server started of the first two servers listed in the fme_license.dat file

becomes the master node.

Start the servers in the order shown in the following example:

SERVER host1 1223344 27009

SERVER host2 9384749 27009

SERVER host3 2038404 27009

VENDOR safe

FEATURE FME . . .

. . .
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Therefore, the first server to start—host1—becomes the master node; host3 never

becomes the master node.

There is no time limit for starting all of the servers.

Unlike independent servers, each SERVER line requires a port number. The port number

in this example is 27009. You can modify the port numbers to any unused port number

in the range 1024 to 32000.

You can change the order of the SERVER lines to suggest which node is the master node,

however we recommend you keep the order shown in the preceding example.

Install FME on Client Computers

When the server license files are running, install FMEon the client computers or on the

Network Server (if you have a fast and uncongested network). If this is not a new install

(but rather a license upgrade from fixed license to floating), ensure that there are no

existing fme_license.dat or fme_license.fmelic files in the C:\Program

Files\FME\licenses directory.

Using a text editor, create a file called fme_license.dat that contains the same three

SERVER lines from the safe.lic files that were used to start the redundant server

nodes. Add a USE_SERVER line after the SERVER lines, as shown in the following example:

SERVER host1 1223344 27009

SERVER host2 9384749 27009

SERVER host3 2038404 27009

USE_SERVER

Place this fme_license.dat file in the FMEclient installation licenses directory; that is,

in the C:\Program Files\FME\licenses directory.

Start FME Registration

Perform this step for each computer that has FME installed.
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For command prompt instructions, see Licensing FME Desktop from the Windows Com-

mand Prompt.

1. Open the FMELicensing Assistant: Start > Programs > FMEDesktop > Utilities > FME

Licensing Assistant.

2. Select Connect to a floating license server, and enter the name of the master node

computer that is hosting the license.

3. Click the Next button.

4. If your configuration contains more than one type of FMElicense, select the license

that you want to use.

5. Click Finish to complete the connection.

Installing a Three-Server Redundant Floating

License Server on Linux
To install Three-Server Redundant Floating Licenses on Linux:
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1. Before You Begin

2. Download and Run the Installer

3. Start the License Servers

4. Run the FMELicensing Assistant and Connect to the First Server

Before You Begin

Ensure that the following requirements are met before beginning the installation:

l You must be running a TCP/IP network.

l Three computers on the network are designated as license servers. The license serv-

ers may be any computers on the network that are visible to all computers that may

dependent on them for their licenses. You should choose computers that are always

running and always connected to the network because the client computers must be

able to communicate with any one license server to use FME. The processing burden

on the licensing server is negligible.

l You must have Administrator privileges to install the Flexera Licensing Manager.

l If the computers you want to use as your floating license servers have firewalls, you

must open a port on each one through which the FlexServer can communicate. By

default, the range of ports used is 27000-27009, although you can also configure

other ports.

l If FlexNet is already installed on your license servers, you still need to perform a new

installation. FMErequires the version of FlexNet that is included in the installer. In

addition, if your organization is configuring license borrowing (see Borrowing a Float-

ing License), you will require LMTOOLSversion 11.8 or newer.

The FMElicense servers cannot be installed on a virtual machine that is built and moved

around among many physical machines. It must be locked to a single fixed MACaddress.
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Download and Run the Installer

Install the floating license server on three different computers using the instructions in

sections Before You Begin through Installing a New Floating License.

Send an e-mail to codes@safe.com and include the FlexNet Host ID, the hostname

assigned to each of the computers, and serial number. To get your serial number, see

the confirmation e-mail you received after purchasing FMEDesktop.

We will e-mail you a file called safe.lic that contains the key code file for the license

code servers. Copy the safe.lic file into each of the FlexServer directories on your

license server nodes.

Start the License Servers

Start the license manager on all three servers, in order based on the following:

The first server started of the first two servers listed in the fme_license.dat file

becomes the master node.

Start the servers in the order shown in the following example:

SERVER host1 1223344 27009

SERVER host2 9384749 27009

SERVER host3 2038404 27009

VENDOR safe

FEATURE FME . . .

. . .

Therefore, the first server to start—host1—becomes the master node; host3 never

becomes the master node.

There is no time limit for starting all of the servers.
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Unlike independent servers, each SERVER line requires a port number. The port number

in this example is 27009. You can modify the port numbers to any unused port number

in the range 1024 to 32000.

You can change the order of the SERVER lines to suggest which node is the master node,

however we recommend you keep the order shown in the preceding example.

To start the License Manager:

% <FlexServerDir>/lmgrd -c <FLEXServerDir>/safe.lic

This action runs the License Manager in the foreground, logging activity to the terminal.

To store the log to a file instead, use the -l option:

% ./lmgrd -c ./safe.lic -l safe.log

When a log file is used, lmgrd detaches as a background process, so there is no need to

explicitly background the application. However, you’ll have to start the server each time

the license server host is rebooted. The system administrator can make sure the pre-

ceding command is run at system start-up time.

Configuring FME Desktop to Use the Floating License

To configure an installation of FMEto use a License Manager, follow these steps.

1. Once FMEDesktop is installed on Linux, log in as the same user who installed FME

Desktop.

2. Navigate to Applications > FMEDesktop > Utilities > FMELicensing Assistant. The

FMELicensing Assistant opens.

3. On the FMELicensing Assistant, select Connect to a floating license server button.
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4. In the Server Name field, enter the name of the master node computer that is host-

ing the license. Click Next.

5. Select the FMEEdition from the list and click Activate.

6. Click Finish.
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Afloating license is installed to borrow a license.

Monitoring Floating License Use
To find out who is currently using FMElicenses from your floating license pool:

1. Ensure the Flexera license manager utility (lmutil) is installed. This tool is installed

with the floating license manager, available on the FME Downloads site

(http://www.safe.com/support/support-resources/fme-downloads/). On Windows,

it is installed by default in C:\Program Files\FlexServer.

2. Create a "license file" that you will use on your computer. You can call it safe.lic, or

any other name ending in .lic. It should contain the following:

SERVER <IP address or name of license server> Any [optional

port number]

for example:

SERVER 107.22.68.36 Any

or

SERVER license1 Any 27000
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You can use either the IP address or the name of the floating license server. We

recommend using the server name because the IP address might change.

Any is required because the license server query requires both the host name and

host id. Any can be used as the hostid. If known, you can also use the MACaddress

of the license server.

The port number is generally between 27000 and 27009. If you do not know what

port is being used for the Safe floating license server, leave this blank, and lmutil

will find it automatically. If you do specify the port, the lmstat query is much

faster.

3. Open a Command Window

Use the safe.lic file to query all details using the command:

lmutil lmstat -a -c <license file>

for example:

lmutil lmstat -a -c safe.lic

This will return a lot of information. You may want to query for specific features in

the license file. You can do this using a command like:

lmutil lmstat -f FME -c safe.lic

The -f flag specifies the feature you want reported. If you want to know who has

checked out any FMEfeature, use -f FME. You can also look for specific license

types like smallworld, oracle, esri, professional, base, and server.

If you do not specify a license file, lmutil lmstat will query all files in its folder

ending in .lic. This can be useful if you have multiple floating license servers; you

can query all of them at once by having a separate .lic file for each, and then omit-

ting the -c flag in the lmutil command.
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Interpreting the output of the lmstat query

The output of lmstat -a looks similar to:

lmstat - Copyright (c) 1989-2012 Flexera SoftwareLLC. All Rights

Reserved. Flexible License Manager status on Wed 02/28/2012 14:49

[Detecting lmgrd processes...]

License server status: 40000@prod

License file(s) on prod: C:\prod\i86_n3\counted.lic:

prod: license server UP v11.5

Feature usage info:

Users of f1: (Total of 4 licenses issued; Total of 1 license in

use)

"f1" v1.0, vendor: demo

floating license

daniel myhost2 19.36.18.26 (v1.0) (myhost1/40000 102), start Fri

2/28 14:29

where:

Output Argument Description

daniel user User name.

myhost2 user_host Host where user is running.

19.36.18.26 display Display where user is running.

v1.0 version Version of feature.

myhost1 server_host Host where license server is running.

40000 port TCP/IP port on server_host where license server is run-

ning.

102 handle License handle.

start Fri 2/28 checkout_ Time that this license was checked out.
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Output Argument Description

14:29 time

For more information about using the lmutil lmstat command, see the "License Admin-

istration Guide" under "Documentation," on the Flexera downloads page, at

http://www.globes.com/support/fnp_utilities_download.htm.

Specifying Floating License Server Ports
This topic explains how to specify ports used by the floating license server. By default,

communication between the floating license server and a client running FMEoccurs on

a random port. Specifying ports can be useful in specific security configurations. For

example, if you have a firewall between your floating license server and a client machine

running FME, you may want to open a specific port for this communication. Or, you may

wish to avoid conflict when multiple FlexNet servers are installed in the same envir-

onment. For example, FMEmay use a random port, but ArcGISmay use a fixed port, and

a conflict will occur if the same port is in use.

To specify Floating License Server Ports

Edit the safe.lic file in your FlexServer directory so that yyyy on the VENDOR line is the

port you want to open for the communication to the client machine running FME. The

port in the SERVER line (xxxx) can also be set, but this is necessary only for a three-

server redundant configuration, or if another FlexNet license server is using a specific

port.

SERVER servername 000c290de0df xxxx

VENDOR safe PORT=yyyy

The port number for the SERVERand the VENDORmust be different. On Windows, the

VENDORport is typically between 1024 and 65535. On Linux, the default VENDORport is
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between 32768 and 61000. The SERVERport is typically between 27000 and 27009. Be

sure to add the VENDORport and SERVERport to your firewall exceptions.

If the VENDORport is specified, the FMErunning on the client machine must specify this

port as well. Using the FMELicensing Assistant, specify the port number when prompted

to "Connect to a Floating License Server," as shown below:

LicenseServerName:yyyy

where yyyy is the port number used in the VENDORline of the safe.lic file.

In earlier releases of FME, the fme_license.dat file in the <FMEDir>\licenses\ directory

must be edited manually. It should contain the following line:

SERVER LicenseServerName Any yyyy

where yyyy is the port number used in the VENDORline of the safe.lic file.

Finally, restart the FME License Server:

l Windows: Start Menu > Programs > FlexNet for Safe Software> Start - Restart FME

License Server

l Linux: % <FlexServerDir>/lmgrd -c <FLEXServerDir>/safe.lic

Borrowing a Floating License
If your FMEDesktop product uses a floating license, and your organization supports this

option, you can borrow a license for offline use.

A fixed license configuration does not allow you to borrow a license. In addition to a

floating license, you need a floating license server with the license borrowing cap-

abilities enabled.

License borrowing requires LMTOOLSversion 11.8 or newer.
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If a license is available, you can borrow it and run FMEfor the maximum period, as spe-

cified in your license file, on a computer that will not be connected to the license server.

The default period is 30 days.

If a different license period than the default is required, ask your System Administrator

to contact us at codes@safe.com.

When the borrowing period expires, the license also expires. After the expiry date, the

license automatically becomes available for other users to borrow.

You do not have to return the license after an expiry date; however, you can choose to

return a license early. See Return the License.

test

testtesttest

To Borrow a Floating License

1. Connect to the Floating License

2. Specify the Terms of the License

To Return a Borrowed License

l Return the License

Connect to the Floating License Server

To borrow a license, you first need to connect to a floating license server. (Please see

your System Administrator if you do not know the server name.)

1. Open the FMEDesktop Licensing Assistant by clicking Start > Programs > FME

Desktop > Utilities > FMELicensing Assistant.
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2. Select Connect to a floating license server. In the Server Name field, enter the name

of the floating license server.

3. Click Next.

4. Select the license type from the list, and click Activate.

5. Click Finish.

Licensing 74



You will see a message when you are successfully connected to the floating license

server.

To borrow the license for offline use, you will have to start FMEWorkbench and

specify the terms of the license. See Specify the Terms of the License.

Specify the Terms of the License

To access the License Borrowing option, start FMEWorkbench:

1. Click Start > Programs > FMEDesktop > FMEWorkbench.

2. Click Tools > License Borrowing.

3. Click Yes, borrow a license for, and then enter or adjust the number of days. Click

OK to close the dialog.

4. Click OK.

You have successfully borrowed the floating license for the specified number of

days.

To run FMEDesktop during this time frame, you do not need to be connected to the

license server.
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Return the License

To return a borrowed license before the time expires:

1. Start Workbench.

2. Click Tools > License Borrowing.

3. On the License Borrowing pane, select Yes, return the borrowed license early. Click

OK.

4. Click OK to close the dialog.

The license is now available for other FMEDesktop users to borrow.

You cannot change or update licenses when you have borrowed a floating license.

You must first return a borrowed license.

Restricting Licenses to Users or Groups
You can restrict floating licenses to specific users, groups, or machines. Create a file

called safe.opt in the FlexServer directory. There is no need to reference this file in any

other configuration files; FlexNet knows to look for it automatically. However, the file

must be named safe.opt, and it must be in the same folder as safe.exe.

Any licenses reserved for a user are dedicated to that user. Even when that user is not

actively using the license, it is unavailable to other users.

Here is an example of an options file:

RESERVE 1 professional GROUP groupA

GROUP groupA xxxx yyyy

RESERVE 1 professional GROUP groupB

GROUP groupB aaaa
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This example reserves one FMEDesktop Professional license for users xxxx and yyyy,

who are in group groupA, and one Professional license for user aaaa, who is in group

groupB. GROUP member names are case-sensitive.

To restrict a license to specific hosts (i.e. machines) instead, replace the keyword

GROUP with HOST_GROUP.

For more documentation, including additional options, see <FlexServer>\Docu-

ments\LicenseAdministration.pdf, where <FlexServer> is the directory where you

installed the FlexNet software.

Troubleshooting Floating Licenses

Specifying the FME Edition to Use

If your floating license service supports multiple editions of FME, you can use the

flexlm_config.dat file to tell FMEwhat edition to use.

To determine the FMEeditions you are licensed for, consult the safe.lic file on your

license server.

To specify the FME Edit ion to Use

On the computer that is running FMEDesktop, edit (or create) flexlm_config.dat in the

<FMEDir>\licenses\ folder.

The contents should be the following two lines:

Registered Product=<FME edition name>

<Displayed name in FME>

For example:

Registered Product=smallworld

FME Desktop Smallworld Edition
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<FME edition name> is case-sensitive. <Displayed name in FME> appears when you

navigate to Help > About in FMEWorkbench or FMEData Inspector.

Possible values for FMEEdition Name are:

FME Edition Name Displayed Name in FME

professional FMEDesktop Professional Edition

esri FMEDesktop ESRI Edition

database FMEDesktop Database Edition

smallworld FMEDesktop Smallworld Edition

System error 1067 has occurred

Symptoms

The following error occurs following an attempt to start the license server:

system error 1067 has occurred

Cause

This error can occur if you were provided an invalid license file.

Resolution

Open the safe.lic file that you saved to your FlexServer directory. (For example: C:\Pro-

gram Files\FlexServer\.) It should contain a number of lines starting with 'FEATURE'.

If the file only has the following contents, then it is invalid:

SERVER 0022fb821528 skyfire

VENDOR safe

USE_SERVER

Send your hostid.txt (Start > Programs > FlexNet for Safe Software > View hostid.txt) and

safe.lic files to codes@safe.com and mention that the license file is empty. Anew license

file will be generated for you.
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The License Server will not Start on Linux

The FlexNet license server fails on Linux

Symptoms

On the client machine, the error message is:

....License system failure. Check that the safe daemon version is

newer than the FME client version. Program Terminating.

On the license server, the error message is:

./lmgrd -c ./safe.lic -l safe.log

>-bash: ./lmgrd: No such file or directory

Cause

FlexNet is missing necessary libraries to run on Linux

Resolution

On the license server, install lsb-coreby typing the following command in the Linux ter-

minal:

sudo apt install lsb-core

Access to Floating License Times Out Over VPN

Access to the FlexNet floating license over a virtual private network (VPN) may time out

if the network is slow. To minimize this issue, set the FLEXLM_TIMEOUT environment

variable.

1. Open the Windows System Properties dialog (Start > Control Panel > System >

Advanced System Settings.

2. On the Advanced tab, click Environment Variables.

3. Under System Variables, click New.
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4. In the Variable name box, enter: FLEXLM_TIMEOUT

5. In the Variable value box, enter: 1000000

6. Click OK to close each dialog box.

Licensing from the Linux Command Line

To activate a single-fixed license with your serial number

l Run:

./fmelicensingassistant --serial <serial-number>

To get your serial number, see the confirmation e-mail you received after purchasing

FMEDesktop.

To activate a single-fixed license with a trial code

1. Go to https://www.safe.com/trial-code/ to generate a trial code.

2. Run:

./fmelicensingassistant --trial <trial-license-code>

To activate a license file provided by Safe Software

1. Complete steps 1-3 under Installing a License File Provided by Safe Software.

Note: To obtain the registration key, navigate to the FMEDesktop installation

folder and run:

./fmelicensingassistant --key

2. Run:

./fmelicensingassistant --file <filename>
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To configure FME Desktop to use a floating license

1. Complete steps 1-5 under Installing a Floating License on Linux.

2. Run:

./fmelicensingassistant --floating <server>[:<port>] <FME-Edi-

tion>

Note: For information about specifying <FME-Edition>, see Specifying the

FME Edition to Use.

To configure FME Desktop to use a three-server redundant

floating license

1. Complete steps 1-3 under Installing a Three-Server Redundant Floating License

Server on Linux

2. Run:

./fmelicensingassistant --floating <master-node-server>

[:<port>] <FME-Edition>

Note: For information about specifying <FME-Edition>, see Specifying the

FME Edition to Use.

Getting Your Current Licensing Status
To find out the current licensing status of your FMEDesktop installation, open the FME

Licensing Assistant. In Windows:

Start > All Programs > FME Desktop > Utilities > FMELicensing Assistant

The Licensing Assistant opens and displays the current licensing status. For example:
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See Also

l About the Registration Key
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Other Common Tasks

Installing the Software Development Kit for FME
Desktop
The FME Desktop installer allows the option of installing the Software Development Kit

(SDK) for FME Desktop. The SDK provides access to the FMEObjects and FMEPlug-in

Builder APIs. You can use the APIs to create your own applications and plug-ins that

make use of FMEfunctionality.

Installing Grid Shift Files
FMEsupports conversions between coordinate systems using different datums. Many

datum transformations are not mathematically definable and require the use of grid of

shifts. If you attempt to perform a datum transformation of this kind without the appro-

priate grid shift file in place, FMEstops the translation.

Installing Grid Shift Files on Windows
When you install FMEfor Windows, the grid shift files provided by Safe Software are

automatically installed in the correct location.

If you have already installed FME, you can find more information on which files are

included by opening Workbench help and clicking on the Coordinate Systems topic, or

by choosing Tools > Browse Coordinate Systems and pressing the F1 key.

You can manage grid shift files by choosing Tools > FMEOptions > Coordinate Systems.

Click the Help button for more information on how you can maintain grid shift files.
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Installing Grid Shift Files on Linux
When you install FMEfor Linux, the grid shift files provided by Safe Software are auto-

matically installed in the correct locations.

You can find more information on which files are included in Linux and UNIXinstall-

ations by viewing our FMEFME Community site:

FME Knowledge Center.com/index.php/Datum_Transformations_and_

Grid_Shift_Files

The files in the Reproject subdirectory of your FMEinstallation folder include a path to

the location of your grid file. The order in which the grids are listed is the order in which

FMEuses them.

To register a file, add the full pathname of the file to the beginning of the appropriate

.gdc file. For example, in Nad27ToNad83.gdc, add:

fmehome\Reproject\GridData\Canada\NTV2_0.gsb

To make sure the files were registered correctly, check the log file when you run a trans-

lation.

If you have access to the FMEWorkbench user interface, you can manage grid shift files

through the Workbench > Tools > FMEOptions menu. Click the Coordinate Systems icon.

Using FME Desktop with Third-Party Applic-
ations
FMEDesktop integrates with a number of popular GISapplications. Visit www.safe.com

for more information.

This section provides instructions for using the FMEIntegration Console to extend any

applicable third-party applications.
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About the FME Integration Console
FMEApplication Extensions are products that use or embed FMEfunctionality in other

applications. The exact functionality varies from product to product, but can include the

ability to read datasets not native to that application, to export to non-native datasets,

or to convert between two non-native formats.

FMEcan "extend " several different applications. Some extensions are packaged as part

of FME, some are sold as add-ons, and some are packaged as part of the other GIS

application. Unless they are packaged as part of FME, support for Application Extensions

is usually provided by the application vendor.

For information about how FMEworks with other applications, please see Solutions for

GISApplications.

Note: FMEdoes not currently extend any applications on Mac or Linux.

Installation Notes

When extending an application using FMEDesktop, please be aware of the following:

l 64-bit and 32-bit applications can only be extended with the 64-bit and 32-bit ver-

sions of FME, respectively.

l Fixed (node-locked) licenses of FMEDesktop will automatically extend compatible

third-party software installed on the same system. You can easily revert the exten-

sions.

l FME cannot extend shared applications that are installed on a different machine.

FMEand the application to be extended must be installed on the same logical

machine, whether it is a physical machine or a virtual machine.

Using the Integration Console
Extending Applications
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Menus and Windows

Reverting Applications

Troubleshooting

Integration Console Menus and Windows
The File and View menus contain basic window-level commands that allow you close

the application or adjust the visible areas.

Through the Help menu, you can view the current FME build number, and check for

FME updates.

Log Pane

The log pane shows status information and results.

Properties Pane

Click on the name of the application to display its Properties:

Property Value

Application The name of the application.

Status The FME build number that extends
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Property Value

the application. The build number

will change each time you update

FME.

Extendable Is this application extendable by

FME?AYes in this column indicates

that the application is ready to be

extended.

Extended Is this application extended by

FME?If No, then you can extend the

application from the Action column.

FME Build The current FME build installed on

your machine.

FME Home Path The location of the FME installation

folder.

Buttons

Copy Text Copies the properties so you can

paste details into an e-mail applic-

ation or text file. This information

might be required if you need to

troubleshoot an installation.

Options This button is enabled only when

certain third-party applications are

installed.

When it is enabled, you can set

application-specific top-level

defaults.
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Extending Applications
After installing FMEDesktop, open the Windows Start menu, and click the Programs (or

All Programs) submenu. Click FME Desktop > Utilities > FME Integration Console.

Note: To ensure that you do not encounter any integration issues, we recommend

that you run the Integration Console with Administrator privileges. To do this, right-

click on the Integration Console menu entry, and select Run as administrator, as

shown here:

When the FME Integration Console starts, click the Extend button next to the applic-

ation. (Note that the application must be closed.)

FME will scan your machine for any installed applications that can be extended to sup-

port FME. The results appear in the Application column.

If the status of an application is Not Extended, the Action column will show an Extend

button. Press the button to extend the application. The log pane will display inform-

ation.
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The Log will display the message Extend Successful.

Note: Open the extended application to ensure that FME has been successfully

extended from within that application. In the example above, FME is extended with

FME Extension for ArcGIS. To check this extension, open the Extensions window

from ArcCatalog or ArcMap (from the Customize > Extensions menu in ArcGIS10.x)

and ensure that FMEExtension for ArcGISis selected.

Menus and Windows

Troubleshooting

Reverting Applications
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Reverting Applications
If the Status of an application is Extended, the Action column will contain a Revert but-

ton.

Note: Ensure that the extended application is closed.

Press the button to revert the application to a Not Extended state.

The log pane will display status information.

Extending Applications

Troubleshooting

Troubleshooting
Always make sure an application is closed before extending or reverting it in the

FME Integration Console.

If an application status does not show Extended:

l Ensure that you have the correct license for extending the application. Training

licenses will not work.

l Ensure that you are using the correct architecture version of FMEDesktop for the

application you are trying to extend. For example, AutoCAD Map 3D is only available

in a 64-bit version, and therefore must be extended using 64-bit FMEDesktop.

l Ensure that you have the correct license for extending the application. Training

licenses will not work.
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